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April Meeting Recap: RoboHelp X3: A Discussion and
Demonstration
By Nancy Carpenter

RoboHelp creates help systems for Win-
dows and web-based applications. It is one
of a suite of products that support produc-
tion of help systems, interactive tutorials,
and pdf preparation. For our April chapter
meeting, Leslie Johnson demonstrated two
of these products, RoboHelp and
RoboDemo.

The goals of a help system are to answer
questions as they are asked and to provide
comprehensive documentation. RoboHelp
is eHelp’s proprietary format, and RoboHelp
HTML — a section of the overall product
— is a help authoring tool that can produce
cross-browser and cross-platform help files.
RoboDemo, another section of RoboHelp,
produces small-size interactive tutorials.

eHelp is positioning the X3 version of
the product to take the niche that
ForeHelp left. The projects run on a
browser. Here are some features that
could help meet your needs.

RoboHelp
RoboHelp imports files in numerous for-
mats, including Microsoft Word and
FrameMaker .mif files. FrameMaker files are
easier to use now. A plugin can convert the
whole book to .mif, and upgrades are being
made to support FrameMaker files more fully.

RoboHelp produces the common help files
such as HTML, WinHelp, WinHelp 2000,
dynamic HTML, Java Help, and Oracle Help.

Like most help authoring systems, it pro-
duces a 3-pane format with a toolbar and
header at the top, text in the largest sec-
tion, and navigation tools on the left.
Navigation usually includes a table of
contents, an index, and full text search.
The text incorporates cross-references,
context sensitivity, browse sequences,
and pop-ups.

The WebHelp format uses a cascading style
sheet that supports older browsers. This
involves nesting an embedded style sheet,
an external style sheet and inline styles that
override all others. If the project does not
look good in Netscape, you can edit the
related .css file in the project.

RoboHelp has a WYSIWIG view, a True
Code view that reveals the HTML and Java
code, a link view to show how the parts are
linked, and a topics view that lists topics.
Of course, you can edit the code in any text
or HTML editor, and can edit the WYSIWIG
view in Microsoft Word 2000.

Context sensitivity provides help within
a software program when you press a
Help button or another function key.
This requires a link from the screen’s
Help button to the proper location in
the help system. You can develop your
own map file or have RoboHelp develop
it. This is a cross reference between the
help button and the project.

Other helpful features include:

• Merge projects at run time or use a
plugin that merges them without go-
ing through a server.

• Use conditional tags to select sections.

• Create an index manually using the In-
dex tool. You type the keyword then
drag and drop the project that would
open on this keyword.

• Insert external hyperlinks.

• Split the project into sections based
on selected paragraph styles.

• Localize a project. Default text such as
messages in the help system can be
translated into a selected language.

(continued on page 5)
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Message from the President
by Alan Houser

“You’re in for a tough time. However, if you
can make it through this [economy], you
will be in really good shape.”

A well-known local entrepreneur and jour-
nalist said this to me at a networking event
late last year when I introduced myself and
described my consulting business. I took
two things from his advice: validation that
our economic circumstances are extremely
challenging, and affirmation that, in the long
run, demand for the services of technical
communicators will again be strong.

I believe these words ring true for all of us
in the technical communication field. Many
of you whom I’ve come to know have dealt
with unemployment (for full-timers) or a drop
in demand in your services (for freelancers
and consultants) during the past 2-3 years.
Several people with long-standing creden-
tials in our field have commented to me that
they’ve “never seen it this bad.”

Whether or not this is the worst “high-tech”
recession in history, we must remember that
tough times have happened in the past. I
recently heard a professor at Carnegie
Mellon’s Graduate School of Industrial
Administration mention that he had started
a high-tech business in 1969. Many of the
more senior people in the room gasped. One
even said out loud, “That was a really tough
time.” When I entered the technical writing
profession in the late 1980’s, one of my first
memories was of watching laid-off co-work-
ers carry boxes of belongings to their cars.
In only a few short years, then-giants of
the computer industry like Wang and Digi-
tal Equipment Corporation either disap-
peared or decreased drastically in promi-
nence and stature.

We must also remember that these economic
times will end. There are small, yet encour-
aging, signs that this may be happening
already. I’m seeing more employment
postings for technical writers than I’ve seen
in some time. I’m seeing more high-tech
economic activity than I’ve seen in some
time. I’m seeing more writers – some of

whom who have been job-hunting for some
time – find work.

Whether an economic recovery is upon
us, or is still down the road, remember the
entrepreneur’s words – “If you can make
it through this [economy], you will be in
really good shape.” Demand for our pro-
fession can only become stronger as tech-
nology-based solutions permeate more
broadly across society. Even as technol-
ogy becomes more of a commodity, there
will always be a need to support people
in using technology-based products and
services. In providing this support, mem-
bers of our profession will be creating and
delivering information for more audiences
and delivering that information in more
ways than we have ever done before.

To be part of this next wave of technical
communication, we must maintain and im-
prove our skills, learn and apply relevant
new technologies, and stay current with
industry trends. As a result, when the time
comes, I expect that each of us in the tech-
nical communication profession will be “in
really good shape.”
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WorkQuestΤΜΤΜΤΜΤΜΤΜ Group Shares Information, Ideas

The Pittsburgh Chapter’s WorkQuestΤΜ

group continued its weekly meetings in
March.

March 11th – Good Networking
Interviews
Guest speaker Glenn Schillo, a lawyer, me-
diator, and grant writer, focused on good
networking interviews. He stressed that
when speaking with someone that you hope
might give you a job lead, you should be
polite, don’t expect them to offer you a job,
and be grateful for any help that you get.
Some of his suggestions included:

• Establish a rapport with your contact

• Don’t ask for a job, ask for guidance
in your job search, their insight into
the job market, etc.

• Ask for comments on the content of
your résumé

• See if they can give you three or four
other contacts who may lead to a job
interview

• Ask for permission to keep in touch
with them

• Send a written thank-you letter

March 18th – Asking Questions at Your
Interview
WorkQuest™ member Rox Vanguard spoke
to us about good first interview questions.
Much of his research for this topic came
from the book Don’t Send a Résumé: And
Other Contrarian Rules to Help Land a Great
Job by Jeffery Fox. Rox told us to think of
an interview as a sales call, since you are
selling yourself. First find out what the in-
terviewer is looking for then tailor your
questions and responses to match his
needs. Employers like candidates who ask
questions about the company and listen to
the answers. Don’t talk about yourself all
of the time. If your interviewer says some-
thing wrong or offensive, don’t correct them
and don’t react. Rox gave us a list of 21

questions from the book that you can ask
an interviewer. Here are a few of them:

• Why is your company successful?

• What does it take to be successful
here?

• What differentiates you and your
products from your competition?

• What are your expectations for the
job?

• What are the concerns about this
position?

March 25th – Psychological and Skills
Testing
WorkQuest™ members Joyce Hall and Jim
Gogots, along with their friend Judith Kajder,
spoke on psychological and skills testing.
Many companies ask you to take skills or
psychological tests as part of the job inter-
view process. These types of tests are also
available for your personal use from test-
ing services for a fee, or free from several
sources including the Pennsylvania Career
Links job service (through the Job and Ca-
reer Education Center at the Carnegie Li-
brary in Oakland), and Priority 2, a job
search self-help group.

Joyce told us that she had used testing ser-
vices for her personal use in the past, and
felt that they were a valuable tool for help-
ing to define and focus your career goals.
Joyce warned that if an employer gives a
psychological test, it must be a test that is
proven valid, which means that the test must
give them information relative to the quali-
ties they are assessing. In addition, the test
is required to be accurate, meaning that it
gives consistent results.

Judy, a former career counselor and job
placement professional, discussed some of
the different types of testing employers do.
She said that many companies do either
skills testing or employment testing, or a
combination of the two. Employment test-

ing usually evaluates the integrity, aptitude,
and personality of the candidate.  Employ-
ment testing is often done because a job
involves handling money or company se-
crets, because the employer wants to know
if the candidate will fit in to the work envi-
ronment, or because the candidate needs a
particular level of intelligence to handle a
position.

Judy informed the group that employers
must be fair in the testing process. They
must give the same test to all candidates
who apply, and they must give the test to
all candidates under the same conditions
(time of day, lighting, etc.). Tests can in-
clude questions about many different top-
ics, such as drug and alcohol use, honesty
and personality traits.

April 1st – Tough Interview Questions
WorkQuest™ member Dennis McCarthy
led a discussion on how to answer difficult
interview questions. Dennis gave the group
a list of resources (books and Internet sites)
that give some examples of difficult ques-
tions you might get in an interview and con-
structive ways in which to answer them. He
also brought a number of books with him.
Group members took turns reading ques-
tions out of the book and having other
members answer the question. Everyone
then discussed the good and bad points of
the ways in which the questions had been
answered. One point that Dennis brought
up was that an interviewer might ask a ques-
tion not just to get you to give him informa-
tion, but to see the manner in which you
deal with that type of question.

WorkQuest™ was formed as a resource for
you. Although the meetings are geared to-
ward writers, everyone who is looking for
work is welcome to attend the meetings.
Many interesting topics are planned for the
next month. Notices of the meetings can be
found on the WorkQuest™ web site http:/
/home.earthlink.net/~workquest/.
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People News
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Welcome:Welcome:Welcome:Welcome:Welcome:

Tracy Grieco

(new member)

Notes from the National Office
STC’s 51st Annual Conference - Call for
Proposals
The call for proposals for STC’s 51st An-
nual Conference was mailed as an insert
with the April 2003 issue of Intercom and is
posted on the STC Web site at www.stc.org/
51stConf. The deadline for the Society of-
fice to receive proposals is August 1, 2003.

The conference will be held May 9-12, 2004,
in Baltimore, Maryland. The conference
theme is “Navigating the Future of Techni-
cal Communication.” For more information,
please contact Buffy M. Bennett at
buffy@stc.org.

************

Nominating Committee Seeks
Candidates for Society-Level Positions in
2004
Would you like to help STC remain a vital
organization?

Are you good at listening to and imple-
menting ideas? Do you think you can help
direct and administer Society-level ac-
tivities? Would you like to represent our
membership on ceremonial occasions?
Could you help coordinate an array of
programs beneficial to our profession?
If your answers are “yes,” tell the STC
nominating committee that you would be
interested in running for office. If you
know another member who should be
considered a candidate for a position on
our international board, please add that
person’s name, too.

The members of this year’s nominating com-
mittee are Michelle Ratcliffe (manager),
Suncoast chapter; M. Katherine Brown,
Snake River chapter; Nan J. Fritz, Boston
chapter; and two others to be determined
in this spring’s election. Please feel free to
discuss your ideas with any of these people.

Open Positions and Qualifications
During the STC year ahead, the following
positions will be filled by election:

• Second vice president

• Secretary

• Director-sponsor for Region 4

• Director-sponsor for Region 6

• Director-sponsor for Region 8

• Two nominating committee members

All candidates must be senior members.
Candidates for second vice president must
have extensive leadership experience, pref-
erably in positions at the Society level.
Candidates for secretary should have
strong communication skills and leader-
ship experience at the chapter or regional
level.  Candidates for director-sponsor
should have a history of successful STC
leadership, preferably at the chapter or the
regional level.

The nominating committee welcomes your
suggestions about potential candidates for
the positions listed here. If you think that
you or someone you know should be con-
sidered, please fill out the accompanying
form and return it to STC by August 1, 2003.
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(continued from page 1)

April Meeting Recap: RoboHelp X3: A Discussion and
Demonstration

• Set the alternative fonts.

• Set font size in percent as well as point
size. Percent is not one of the selec-
tions in the dialog box, but it accepts
percent if you type it.

• Add a Print button.
RoboDemo
RoboDemo produces small-sized interactive
tutorials using Flash format. It has 85 per-
cent of the Flash functionality without the
steep learning curve. You will need a Flash
plugin to get the full functionality.

The interface is similar to PowerPoint. Each
page is a screen shot to which you apply
audio and captions, and set to fade in or
out on cue.  RoboDemo also has a band-

width analysis that helps you to decide if
your users can to view the presentation.

Project Management
You can manage the development of your
help project in RoboHelp itself. You can
organize the sections of the project into
files and folders, then generate a table of
contents from these. Using this table of
contents, you can track progress, export a
report, and email it to reviewers. In addi-
tion, in conjunction with RoboHelp Office
Pro, it gives real-time analysis of user ac-
tivity on a help site.

Training
The software should be fairly easy to learn
since its user interface is familiar to Word,

PowerPoint, and FrameMaker users. You
can get a 15-day trial version of X3 to evalu-
ate. The tool itself has help resources. eHelp
has an on-line help community that posts
samples of work and a library of Skins that
you can use to customize the look of the
help system. The help system within
RoboHelp contains a sample of a typical
application, complete with all common top-
ics. You can edit it to produce a project.

Leslie  Johnson has used RoboHelp since
the early 1990’s to develop projects in
various Help formats including WinHelp
and WebHelp. She is an STC member.
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Access Database Primer, Part 4
by Robert P. Mohr

In last month’s article, I discussed how to create a query and
how to create a report based on the results of the query. So far
in this series, we have created tables, forms, queries, and re-
ports. Each of those objects were accessed individually through
the Database Window. In this article, I’ll discuss how to create
a menu-driven interface for the database and how to change
the way Access behaves when the database is opened.

Access contains a very useful utility called the Switchboard
Manager. It enables you to build a menu-driven interface, and
add a little polish, to your database. Before creating the menus,
there’s one bit of housekeeping to do: create a simple macro to
close the database and exit Access.

To create the macro:

1. Select Macros from the Objects list in the Database Window,
and click the New icon. The Macro Designer is displayed.

2. Select Quit from the drop-down list in the Action column.
Notice the Save All option appears at the bottom of the
screen. This will automatically save the contents in any open
objects and close them without prompting.

3. Select File > Save, and name your macro, QuitAccess.

4. Select File > Close to close the Macro Designer.

Now create the main menu:

5. Select Tools > Database Utilities > Switchboard Manager.
You are prompted to create a new Switchboard. Click Yes.
The Switchboard Manager dialog box is displayed with a
default page listed (Figure 1).

Figure 1: Switchboard Manager dialog box

6. Click New to create a page for the Reports menu.

7. Type Reports Menu for the name of the new Switchboard
page, and click OK.

8. Select the default Switchboard page name and click Edit.
9. Replace the current Switchboard name with Mini-Knowledge

Base Main Menu. This becomes the window title.

10. Click New. Now you can create a menu option.
11. Replace the default Text with &Content Input Form. (The

“&” creates an accelerator key, so that the menu option can
be accessed using the Alt+C keystrokes.)

12. Select Open Form in Edit Mode from the Command drop-
down list.

13. Select Personal Knowledge Base from the Form drop-down
list (Figure 2).

Figure 2: Enter a menu option

As you might have guessed, the Text box holds the name of the
option as it will appear on the menu. The Command box tells
Access what to do when the option is chosen. Since I chose a
form operation, The Form box is where I specify the specific form.

14. Click OK to create the menu option.

15. Repeat steps 6 thru 10 to create menu options for the Source
Entries and Topic Entries forms.

16. Click New to create a menu option to access the Reports
Menu.

17. Enter &Reports Menu in the Text box.

18. Ignore the Command box because it defaults to Switchboard
page.

19. Select Reports Menu from the drop-down list.
20. Click OK.

21. Click New to create a menu option to close the database and
exit Access.

22. Enter &Exit in the Text box.
23. Select Run Macro in the Command box.

24. Select QuitAccess in the Macro box.

25. Click OK to complete the menu option.
26. Click Close to return to the main Switchboard Manager screen.

Now the Reports Menu can be created.

27. Select the Reports Menu Switchboard page and click Edit.
Now you can enter options to access the two reports.

28. Click New. This should look familiar to you by now.
29. Replace the default Text with Knowledge Base &Contents.

30. Select Open Report in the Command box.

(continued on page 7)
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31. Select Knowledge Base Contents in the Report box.
32. Click OK.

33. Repeat steps 24 thru 28 to add the List of MS Word Refer-
ences report.

34. Click OK.
35. Click New to add an option to take you back to the main

menu.

36. Replace the default Text with &Return to Main Menu.

37. Ignore the Command box because it defaults to a Switch-
board page.

38. Select Mini-Knowledge Base Main Menu from the drop-
down list.

39. Click OK.

40. Click Close to return to the Switchboard Manager dialog
box.

41. Click Close again to close the Switchboard Manager dialog
box.

If you select Forms in the Objects list, you should see a new
form called Switchboard. Double-click it to view it. Mine looks
like this:

Figure 3: Default view of the Switchboard form

The look of the Switchboard form can be modified using the
Form Designer. You can alter yours if you wish. Here is how my
Switchboard form looks after a few changes:

Figure 4: Modified Switchboard form

The last step is to control how Access behaves when this data-
base is opened:

42. Select Tools > Startup to display the Startup dialog box (Fig-
ure 5).

43. Type Mini-Knowledge Base in the Application Title box.

44. Select Switchboard from the Display Form/Page drop-down
list.

45. Turn off Display Database Window.

46. Click OK to save the changes and close the dialog box.

Figure 5: Startup dialog box with changes made

Test the start-up settings and the Switchboard menus:

47. Close Access.

48. Create a shortcut on your desktop to your database file.

49. Double-click the shortcut to launch Access and load your
database. You should see your main menu and standard
toolbar within the Access environment.

Obviously, the idea of the menu interface is convenience when
entering and retrieving data and reports. If you want to perform
maintenance operations, such as editing a form, changing a table

or some other object, click the Database Window  icon. You

can then access any of the objects in the database as explained
in previous articles.

You can go to www.writemohr.com (Free Stuff section) and down-
load a copy of my versions of the databases in their current state
at the end of each article. This concludes the series on creating a
database application with Access. I hope you found it useful,
and I encourage you to experiment with Access to learn how it
can help you be more productive.

Bob Mohr is a senior STC member and the author of  The Ele-
ments of Word. He can be reached via e-mail at
rpmohr@writemohr.com.

Access Database Primer, Part 4
(continued from page 6)
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May Spring
Fling
Join us in closing out the 2002-2003 STC
season. Enjoy food, drink, and tech talk
outside on the patio at the Church Brew
Works in Bloomfield. For directions, please
visit our chapter web site at
www.stcpgh.org/calendar.

RSVP by May 27 to:

Darlene Mullenix

412-288-8676 or

dmullenix@federatedinv.com

Friday, May 30, 2003

4:45 to 6:45 p.m.

Church Brew Works

3525 Liberty Avenue

Bloomfield section of Pittsburgh

Cost is:

$10 for members

$12 for non-members

$5 for students and unemployed

May Independents and Lone Writers SIG Meeting –
The Value of the Writer
The latest buzzwords in the industry seem
to be ROI – Return On Investment – and
value.  Some questions companies pose
when making an investment decision in-
clude: “What kind of ROI can I get on
this purchase?” “What is the value of this
investment for the company?”  These
buzzwords are not only used when a com-
pany is looking to purchase a product or
service, but they are also used in the de-
cision to increase corporate headcount.

So, how do we as technical writers answer
these questions? How we can provide a
significant ROI for a potential employer or
client? How do we prove how valuable we

are? And most important, how do we ex-
plain what exactly it is that we do?

Please join us in our attempt to answer these
and other questions about the value of the
writer in a company at the Independents
and Lone Writers SIG meeting at 6 p.m.,
Tuesday, May 20, at the Panera Bread Com-
pany on the Boulevard of the Allies in the
South Oakland.  Barb Stanton and John
Clark will help generate a discussion on ways
to illustrate how valuable a writer can be to
a company. Please come with some of your
ideas and methods for answering these
questions as well to help in the discussion.

This discussion is relevant to independent
writers because you need to sell your busi-
ness and convince prospective clients of
the value of solid and effective communi-
cation pieces.  It is important to lone writers
because as the only writer in a company,
you need to let your employer know what
you can bring to the business.

There is no charge for this meeting, how-
ever Panera has great pastries, sandwiches
and salads to purchase.  Please RSVP by
Monday, May 19 to Barb Stanton
(bstanton@seec.com) or (412) 893-0383.

Editorial Note
The next issue of the Blue Pencil will be
published in early August. Would you like
to submit an article? Do you have ideas for
articles you would like to see? Send them
to Meg Papa (mv0t@andrew.cmu.edu).
Have a good summer!
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